




Read the following before installing 
this software
Thank you for purchasing this software. Before installing this software, carefully read the following product 
agreement, which has been provided for this product. Use this software only if you agree to the terms of this 
agreement. By installing this software, you agree to the conditions of its use.

Product Agreement

Portions of this product were created using technology from Softfoundry International Pte. Ltd.

1) General terms

This is an agreement between you (the end-user) and our company for this product.

2) Use of this product

You may install and use this product on only one computer.

3) Limitations on duplications

You may not duplicate this product, except for backup purposes.

4) Limitations on modifications

You may not modify or disassemble this product in any way.

5) Limitations on transfer

This software may not be transferred to or used in any other way by a third party.

6) Warranty

We accept no responsibility for your choice or use of this product or for any damages that may arise 
out of its use.

7) Others

This product is protected by copyright laws.



IMPORTANT INFORMATION: 
REGULATIONS

Federal Communications Commission (FCC) 
Declaration of Conformity (For USA Only)

declares, that the products

complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device 
may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by 
one or more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

- Consult the retailer or an experienced radio/TV technician for help.

Important

Changes or modifications not expressly approved by Tacony Corporation could void the user's authority to 
operate the equipment.

Industry Canada Compliance (For Canada Only)
CAN ICES-3(B)/NMB-3(B)

Responsible Party: Tacony Corporation
1760 Gilsinn Lane
Fenton MO 63026 USA

Product Name: Baby Lock Palette Software Key

Model Numbers: ECS11



Congratulations on choosing our product!

Thank you very much for purchasing our product. To obtain the best performance from this unit and to ensure 
safe and correct operation, please read this document carefully, and then keep it in a safe place together with 
your warranty.

Please read before using this product

For designing beautiful embroidery designs

This system allows you to create a wide variety of embroidery designs and supports a wider range of sewing 
attribute settings (thread density, sewing pitch, etc.). However, the final result will depend on your particular 
sewing machine model. We recommend that you make a trial sewing sample with your sewing data before 
sewing on the final material.

For safe operation

• Do not save any files on the "Palette Software Key" for transferring or storage.

• Do not insert the "Palette Software Key" into your embroidery machine.

For a longer service life

• When storing the "Palette Software Key", avoid direct sunlight and high humidity locations. Do not store the 
"Palette Software Key" close to a heater, iron or other hot objects.

• Do not spill water or other liquids on the "Palette Software Key".

• Do not drop or hit the "Palette Software Key".

For repairs or adjustments

In the event that a malfunction occurs or adjustment is required, please consult your Baby Lock retailer.

Notice

Neither this Reference Guide nor the Instruction Manual explains how to use your computer under 

Windows®. Please refer to the Windows® manuals.

Trademarks

• Windows® is a registered trademark of Microsoft Corporation.

• Other product names mentioned in the Reference Guide and Instruction Manual may be trademarks of 
registered trademarks of their respective companies and are hereby acknowledged.

Important

Using this unit for unauthorized copying of material from embroidery data, newspapers and magazines for 
commercial purpose is an infringement of copyrights which is punishable by law.

Caution

The software included with this product is protected by copyright laws. This software can be used or copied 
only in accordance with the copyright laws.

For additional product information and updates, visit our web site at: 
www.babylock.com

SAVE THESE INSTRUCTIONS
This product is intended for household use.
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Navigating This Guide for Best 
Results

Installation steps
Follow this initial steps to 
install the software.

For people who want to learn 
basic application operations

I am...

.... a Palette beginner.

.... interested in reviewing basic 
operations.

For people who want to 
immediately begin creating 
patterns
I am...

.... an intermediate/advanced 
user of Palette.

.... interested in learning 
operations for specific 
applications and operation 
details.
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How To Use the Manuals

Reference Guide (Printed book/PDF format)

Read this guide before using the software. The guide begins with procedures for installing the software and 
includes precautions and tips for using this software. The second half is filled with tutorials that use key 
features to create embroidery patterns as well as project examples.

• Installation section

1) Read the information about verifying the package contents and installation preparation. (c page 5)

2) Install the software according to the instructions. (c page 6)

3) Learn about the software support information and online registration. (c page 13)

• Basic operation section

1) Learn about key features for creating embroidery patterns. (c page 15)

2) Learn basic screen operations and functions. (c page 17)

3) Try creating sample projects. (c page 28)

• Symbols used in the guide

Instruction Manual

The manual covers the functions and operations as well as various settings of Pallete for all levels of learning 
from beginner to advanced users.

■ Online Instruction Manual

An Online Instruction Manual is available, which can also be accessed from a mobile device. 
Babylock.com/palette11/en

Viewing from the [Start] screen (for Windows® 10 users)

Click . Click [Palette Ver.11] and then select [Online Instruction Manual].

Viewing from the application

Click [Help] in the window of each application. In [Design Database], [Help] is in the menu bar at the 
top of the window.

In other applications, it is located in the upper-right corner of the window.

a : This indicates precautions to be observed during software operations. Since this information is 
necessary for correct operation, be sure to read it when you see this mark.

b : This indicates useful operation tips. Understanding this information will make creating embroidery 
patterns easier and more enjoyable.

b
• For Windows® 8.1 users: Position the mouse pointer in the [Start] screen to display the down arrow in the 

lower-left corner of the screen (below and left of the tiles), and click it.
From the list of applications that appears in the screen, click [Online Instruction Manual] under the title 
[Palette Ver.11].

• For Windows® 7 users: Click  and then [All Programs]. Click [Palette Ver.11] and then select [Online 
Instruction Manual].
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b
• The Instruction Manual is also available in PDF format for use when your computer is not connected to 

the internet.

• The Instruction Manual and Reference Guide in PDF format may be accessed as follows:

- For Windows® 10 users: Click . Click [Palette Ver.11] and then select [Instruction Manual] or 
[Reference Guide].

- For Windows® 8.1 users: Position the mouse pointer in the [Start] screen to display the down arrow in 
the lower-left corner of the screen (below and left of the tiles), and click it. 
From the list of applications that appears in the screen, click [Instruction Manual] or [Reference 
Guide] under the title [Palette Ver.11].

- For Windows® 7 users: Click  and then [All Programs]. Click [Palette Ver.11] and click [PDF] and 
then select [Instruction Manual] or [Reference Guide].

• Adobe® Reader® is required for viewing and printing the PDF version of the manuals.



5

Getting Started

Introduction

Package contents (Full Version Only)

Check that the following items are included. If anything is missing or damaged, contact your Baby Lock 
retailer.

Precautions for using the "Palette Software Key"

• Since this "Palette Software Key" device is required to run the software, its replacement value is the retail 
price of the software. Please keep in a safe place when not in use.

• The "Palette Software Key" prevents unauthorized use of this software. The software cannot be started if 
the "Palette Software Key" is not plugged in.

• The "Palette Software Key" cannot be used as USB media. Do not save embroidery files on the "Palette 
Software Key" for transferring or storage.

• Do not plug the "Palette Software Key" into your embroidery machine.

• Do not format the "Palette Software Key".

• Keep the "Palette Software Key" away from high humidity, direct sunlight, static electricity and strong 
shocks. Furthermore, do not bend the "Palette Software Key".

• Before installing, back up the installer stored on the "Palette Software Key".

• If the installed application is not operating properly, perform the installation again.

• If the computer does not start with the "Palette Software Key" plugged in, unplug the "Palette Software 
Key", and then turn on the computer. Plug the "Palette Software Key" in again to launch the program.

Palette Software Key

Containing the software

* Design is subject to change.

Reference Guide 
(this manual)

Positioning sheet
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Installation

Please Read Before Installation

• Before beginning the installation, check that the computer meets the system requirements.

• In order to install the software on Windows® operating system, you must log on to the computer using an 
account with administrator privileges. If you are not logged on with the administrator account, the password 
for the administrator account may be requested with Windows®. Type in the password to continue the 
procedure. For details on logging on to the computer using an account with administrator privileges, refer to 
the Windows® manual.

• The installation procedure is described for Windows® 10. The procedure and dialog boxes for other 
operating systems may be slightly different.

• If the installation is canceled before it is completed or if the procedure is not performed as described, the 
software will not be installed correctly.

• Do not remove the "Palette Software Key" from the USB port of the computer while the installation is being 
performed. Remove the "Palette Software Key" after the installation is completed.

System Requirements

Before installing the software on your computer, make sure that the computer meets the following minimum 
PC requirements.

Operating system Windows® 7, 8.1, 10 (32 or 64 bit)

Processor 1 GHz or more

Memory 1 GB or more

Hard disk free space 600 MB

Monitor XGA (1024 × 768), 16-bit color or higher

Port
Two or more USB ports (used for connecting the "Palette Software Key" 
and for transferring embroidery data to an embroidery machine)

Device Mouse

Printer
Graphic printer that is supported by your system (if you wish to print your 
images)

Internet access Required for updating Palette

a
• This product may not operate correctly with some computers.
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Installation

Installation Procedure
This section describes how to install the application software.

a
• Before beginning the installation, follow the procedure below to back up the installer onto your computer.

1) Create a backup folder on the computer.

2) Copy the entire [Palette Ver.11] folder from the “Palette Software Key” into the folder created in step 
1).

• Do not delete the data in the [Palette Ver.11] folder on the “Palette Software Key”.

1 Plug the "Palette Software Key" into 
the USB port on the computer.

 After a short while, the [AutoPlay] 
dialog box automatically appears.

 For Windows® 7 users, follow 
step 3 after the [AutoPlay] dialog 
appears.

a
Do not unplug or plug in the "Palette Software Key" until the installation is completed.

b
If the [AutoPlay] dialog does not automatically start up:

• For Windows® 10/8.1 users:

1) Right-click  /  and select [Run] in the command list.

* For Windows® 8.1, move the pointer over the lower-left corner of the screen to show , and 
right-click .

 The [Run] dialog box appears.

2) Type in the full path to the installer, and then click [OK] to start up the installer. 
For example: E:\Palette Ver.11\setup.exe (where "E:" is the drive name used for "Palette Software 
Key")

• For Windows® 7 users: 
Click , then [All Programs]. Select [Accessories] and then click [Run] to display the [Run] dialog 
box. Type in the full path to the installer in the input window.
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2 Click the message appearing in the 
lower-right corner of the screen.

 The [AutoPlay] dialog box 
continues to be displayed.

3 Click [Open folder to view files].

 The [File Explorer] window 
appears.

4 Open the [Palette Ver.11] folder, and 
then double-click the [setup.exe] 
file.

 The [User Account Control] dialog 
box appears.

5 Click [Yes].

 After a short while, the following 
dialog box automatically appears.
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Installation

6 Select the desired language, and 
then click [Next].

7 Click [Next] to continue with the 
installation.

 The license agreement dialog box 
appears.

8 Read the license agreement. Check 
the [I accept the terms in the license 
agreement] box if you agree to the 
terms, and then click [Next].

 A dialog box appears, allowing you 
to select the folder where the 
software will be installed.

9 Check the installation location, and 
then click [Install] to install the 
application.

 When the installation is completed, 
the following dialog box appears.

b
To install the application into a different folder:

1) Click [Change].

2) In the [Browse For Folder] dialog box that appears, select the drive and folder. (If necessary, type in 
the name of a new folder.)

3) Click [OK].

 The [Database Folder] dialog box of the [InstallShield Wizard] shows the selected folder.

4) Click [Install] to install the application into the selected folder.
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10 Click [Finish] to complete the 
installation of the software.

b
• If a message appears, indicating that the computer be restarted, it is necessary to restart the computer.

• If the [Open Online Instruction Manual] box is checked, the Online Instruction Manual will open after 
installation is complete.
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Installation

Uninstalling the Software

1 Click , and then click .

2 Click [Apps].

3 In the [Apps & features] window, 
select [Palette Ver.11] and click 
[Uninstall].

 The message [This app and its 
related info will be uninstalled.] 
will be displayed.
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4 Click [Uninstall].

If [User Account Control] message 
appears, click [Yes].

b
• The uninstallation procedure is described for Windows® 10.

• For Windows® 8.1, right-click [Palette Ver.11 (Layout & Editing)] in the [Apps] screen, and click 
[Uninstall] in the taskbar at the bottom of  the screen. Select this software in the [Programs and 
Features] window, and then click [Uninstall].

• For Windows® 7, click the [Start] button, then [Control Panel]. Select [Programs and Features] in the 
[Control Panel] window. Select this software, and then click [Uninstall].
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Technical Support/Service

Technical Support/Service

Technical Support

If a problem occurs, click [Help] in the screen and select [Customer Support] to visit the "FAQ" in our 
Customer support at (https://www.babylock.com/support/faq/), where you can find answers to frequently 
asked questions and possible causes and solutions to problems.

Contact "Baby Lock Product Support" if the problems are not addressed. Go to www.babylock.com, then click 
on "Customer support".

Online Registration

If you wish to be contacted about upgrades and provided with important information such as future product 
developments and improvements, you can register your product online by following a simple registration 
procedure.

Click [Online Registration] on the [Help] menu of [Layout & Editing] to start up the installed Web browser 
and open the online registration page on our Web site.

www.babylock.com/register

a
Before contacting web site:

1) Have your Windows® operating system updated to the most current version.

2) Find the make and model number of the computer that you are using as well as the Windows® 
operating system version.

3) Obtain information about any error messages that appear. This information will help expedite the 
processing of your inquiries.

4) Check and update the software to the latest version.

a
Online registration may not be available in some areas.
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Checking for the Latest Version of the 
Program

1 Click [Help] in [Layout & Editing], 
then [Check for Updates].

 The software is checked to 
determine whether or not it is the 
latest version.

2 If the message shown on the left 
appears, click [OK].

The latest version of the software is 
being used.

3 If the message shown on the left 
appears, click [Yes] to start 
downloading the latest version of 
the software from the Web site.

a
• This feature cannot be used if the computer is not connected to the Internet.

• It may not be possible to check for the latest version if a firewall is turned on. Turn off the firewall, and 
then try performing the operation again.

• Administrator privileges are required.

b
If the [Always check for most recent version at startup] check box is selected, the software is checked 
at startup to determine whether or not it is the latest version.
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Creating the Desired Embroidery 
Pattern

Key Features of Successful Embroidery 
Design
In order to complete your embroidery project, it is necessary to become proficient in performing operations 
using the following key features. Palette is loaded with tools and functions to assist you in these "key" steps. 
These enable you to achieve your project goals.

Visualizing the 
finished project

I want …

Creating patterns

I want …

Arranging patterns

I want …

to embroider an 
image file that I 
have.
 page 41 
 page 53

to see various 
sample patterns.

 page 21

a sample project 
that I can follow.

 page 28

to use a photo 
or illustration.

to enter text.

 page 33

a design template.

 page 39
 
 page 53

to enjoy arranging 
patterns.

 page 28
 page 66

to rotate patterns.

 page 22

to enlarge/reduce 
patterns.

 page 22

to move patterns.

 page 22
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Key Features of Successful Embroidery Design
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Adding colors

I want …

Enhancing with 
sewing attributes

I want …

Creating embroidery 
data

I want …

Embroidering

I want …

to change color 
combination.

 page 35

to simulate color 
schemes.

 page 23

to make the pattern 
more expressive.

 
 page 48

to change the sew 
types for patterns.

 page 24

to choose the 
sewing order.

 page 25 
 page 65

to preview the 
finished embroidery.

 page 25

to know what I can 
do with the data.

 page 25

to save my 
favorite designs.

 page 27

to manage 
embroidery data 
I create.

 page 26

to embroider with 
my embroidery 
machine.

 page 26
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Turning Your Ideas Into 
Embroidery

Let's look at the basic sequence using each key feature of embroidery design in order to 
create an embroidery project.

Starting Applications
Palette provides five applications helpful with embroidery design. First, let's start up [Layout & Editing], 
which assists you in all "key" processes for creating an embroidery project from importing pattern, shape, 
image and text elements to checking the created/edited embroidery data.

Layout & Editing:
Provides all function necessary to create 
embroidery

Design Center:
Creates embroidery data from an image

Design Database:
Manages created/edited embroidery data

Programmable Stitch Creator:
Allows different stitch patterns to be created

Font Creator:
Creates original fonts
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Starting Applications
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Practical Exercise a

Starting up Layout & Editing

1 Plug the "Palette Software Key" into 
the computer.

Close the [AutoPlay] dialog box that 
appears.

2 Click . 

 A list of applications appears.

3 Click [Palette Ver.11 (Layout & 
Editing)], which appears under the 
title [Palette Ver.11].

 [Layout & Editing] starts up, and 
the startup wizard appears.

b
• For Windows® 8.1, move the pointer over the lower-left corner of the screen to show , and click    
→ [All Programs] → [Palette Ver.11] → [Palette Ver.11 (Layout & Editing)].

• For Windows® 7 users, click   [All Programs]  [Palette Ver.11]  [Palette Ver.11 (Layout & 
Editing)].
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Using the Startup Wizard

Using the Startup Wizard
The startup wizard allows you to access the desired functions and files with a single click.

Practical Exercise b

Using preset settings

1 Click [Set Hoop Size and Fabric] in 
the startup wizard window.

 [Design Settings] dialog appears.

2 Click the [Design Page] tab, and 
then specify the display settings.

For this example, set the [Design 
Page] size to a [Hoop Size] of "130 × 
180 mm", and then click [OK].

 The [Fabric Selector] dialog box 
appears.

3 Click [OK].

Easily creates embroidery 
patterns by using wizards

Provides tips for display, 
hoop, and fabric settings

Allows built-in patterns and 
text to be used

Displays detailed information 
for operations

Easily recalls previously 
used patterns

Manages embroidery data
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Understanding the Layout & Editing Window
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Understanding the Layout & Editing 
Window
On closing the startup wizard, the main (Layout & Editing) window appears. From this window, all functions 
and tools necessary to finish your embroidery project are available.

Practical Exercise c

Displaying the [Import] pane

1 Click the [Import] tab on the right 
side of the window.

 A thumbnail list of patterns that can 
be imported appears.

2 Or, click the [Home] tab on the 
upper-left of the window. Click 
[Import Patterns] in the [Import] 
group, and then click [from Design 
Library] in the menu.

Menus and tools

Viewing 
sewing order

Select the desired commands or tools 
grouped by functionality in the ribbon. 

Check the actual sewing order of each 
embroidered part of the pattern.

Importing attribute 
settings and patterns

Checking 
embroidery data

View patterns to be imported, or 
detailed settings for colors, sew types 
and text.

View an embroidering simulation of 
the created/edited pattern.
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Importing Patterns

Importing Patterns
Begin creating embroidery patterns by first importing the various elements of the design into the editing area. 
Patterns, shapes and text can easily be imported, and your favorite photo can be converted to embroidery 
data by using the "Image to Stitch" functions and tools available in the [Image] tab.

Practical Exercise d

Importing outline shapes

1 Select [Outline Shapes] from the 
[From] selector of the [Import] pane.

2 Select [OL_leaf06.pes] from the 
[Leaves] category, and drag it into 
the [Design Page].

3 Select [OL_flower01.pes] from the 
[Floral] category, and drag it into the 
[Design Page] so that it overlaps the 
first pattern slightly.

Following instructions

Convert the image with Stitch wizard 

By using the image-importing wizards available from the [Image] 
tab, your photos can be easily converted into embroidery data.

Dragging

From the 
Import pane

Shapes, text, design templates and 
more can be reused simply by 
dragging them from the pane.

Using 
path tools

Using the Text and 
Shapes tools

Enhance your designs by using 
input tools to intuitively draw 
shapes and lines.
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Laying Out Patterns
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Laying Out Patterns
After importing the patterns, consider how you would move them around to customize the layout. 
The patterns can be not only rearranged, but also enlarged/reduced or rotated simply by dragging them. 
The more advanced functions to customize the arrangement are also available in the application.

Practical Exercise e

Arranging outline shapes

1 Drag the pointer to draw a selection 
frame around the two patterns to be 
selected.

2 Click [Duplicate] in the [Clipboard] 
group.

 The duplicate appears, overlapping 
the original pattern and offset down 
and to the right.

3 Select the duplicate pattern, and 
drag it into the desired position.

4 Drag the red dot at the top of the 
pattern to the right.

 The duplicate pattern is rotated 
clockwise.

Resizing pattern

Rotating pattern

Moving pattern
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Adding / Changing Pattern Colors

Adding / Changing Pattern Colors
Change the color of each pattern part as desired. In order to beautifully finish an embroidery design, the color 
scheme of the pattern must be considered. 

Practical Exercise f

Changing colors

1 Click the [Home] tab, and then select 

.

2 Hold down the <Ctrl> key and click 
each of the two floral patterns.

3 Click the [Color] tab, and then click 
[To list mode] at the bottom of the 
pane.

 The [Color] pane in thread list 
mode appears.

4 Select [Yellow] from the list as the 
region color.

Both the line color and region color for 
shape patterns can be specified.

 The color of the floral shapes 
changes to yellow.

Changing colors
Using the [Color] pane, you can 
simulate and create a customized color 
scheme simply by selecting the desired 
color from the color palette.
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Specifying Pattern Sew Types
T

u
rn

in
g

 Y
o

u
r Id

ea
s In

to
 E

m
b

ro
id

ery

Specifying Pattern Sew Types
Over twenty sew types can be applied to the lines and regions of a pattern, improving the look of the project. 
By adding detailed settings to the various stitching patterns, there is no limit to the range of ideas.

Practical Exercise g

Changing the sew type

1 Hold down the <Ctrl> key and click 
the two floral patterns.

2 Select the [Shapes] tab.

3 Select [Concentric Circle Stitch] 
from the [Region sew type] selector 
in the [Sew] group.

 The stitching pattern for the inside 
regions of the shapes is changed.

Selecting from various sew types
Sew types can be specified depending the types of 
patterns. Apply the desired type to the outlines and 
regions for changing the appearance of the pattern.
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Viewing a Pattern as Embroidery Data

Viewing a Pattern as Embroidery Data
View the pattern as embroidery data when you near completion of a project that you have visualized, for 
example, to check how it will appear when sewn by the machine or what is the best sewing order.

Practical Exercise h

Changing the sewing order

1 Hold down the <Ctrl> key and click 
the duplicate leaf pattern (frame 5 
and 6) in the [Sewing Order] pane.

2 Drag the selected frames between 
frames 2 and 3.

3 Click  at the bottom-right of the 
screen to begin the stitching 
simulation.

Previewing finished embroidery

The pattern can be previewed in three modes. Use [Stitch View] to check 
the stitching or [Realistic View] to see how the sewn pattern will appear.

Solid View

Optimizing the sewing order

View the sewing order in the [Sewing Order] 
pane, and adjust the order to reduce the 
number of thread color changes and jump.

Viewing stitching in simulator

How the pattern will be sewn by the 
embroidery machine can be reproduced. 
Check the movement of stitching.

Stitch View Realistic View



26

Sewing the Pattern
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Sewing the Pattern
After checking the embroidery data you have designed, transfer it to the embroidery machine to sew. Select 
the method appropriate for the operating environment of your embroidery machine.

Practical Exercise i

Transferring to an embroidery machine using USB media

1 Plug the commercially available USB 
media into the computer.

2 Click [Send] in the [Sew] group of 
the [Home] tab, select [Send to USB 
Media] and then click the 
appropriate drive.

 When the patterns have been 
copied to the USB media, the 
message appears.

3 Click [OK], and then unplug the USB 
media.

4 Insert the USB media into the USB 
port on the embroidery machine, 
and then import the data.

For details on importing data onto the 
embroidery machine, refer to the 
manuals supplied with it.

Transferring to embroidery 
machine

The data transfer method can be 
selected from a menu available in the 
[Home] tab. Select the method 
suitable for your operating 
environment.

USB media

USB cable

Managing data

The create/edited embroidery pattern 
can be saved as data and recalled at 
any time. The pattern can also be 
output in a variety of formats.

Save

Export

Print
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Exiting the Application

Saving/Opening/Printing pattern data file

Exiting the Application

Practical Exercise j

Exiting Layout & Editing

1 Click  in the upper-left corner of 
the window.

 The [File] menu appears.

2 Select the desired command from 
the menu.

A list of the most recently used files, 
starting from the top, appears under 
[Most Recently Used Files].

1 Click  in the upper-left corner of 
the window.

 The [File] menu appears.

2 Click [Exit] in the lower-right corner 
of the menu window.

The application can also be closed by 

clicking  in the upper-right corner 
of the [Layout & Editing] window.
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Creating Various Embroidery 
Designs

This section will take a project introduced in the beginning of this guide as an example to describe the 
functions, tools and operations for creating a well-designed embroidery pattern. Learn practical skills 
and expand your range of ideas. 

Practical Application a

Floral wreath – Arranging stitch patterns –

About stitch patterns

Setting the Design Page size

Click  and select [Design Settings] in the command list. In the dialog box that appears, change [Design 
Page] size to "130 × 180" mm. (c page 19)

We recommend using a built-in stitch pattern in its original size, or resizing 
it only slightly.

Stitch patterns contain a collection of information including needle drop 
points and thread color order. Upon being resized, the stitching becomes 
more dense or light while maintaining the unchanged needle drop point 
pattern. These changes may have an influence on the quality of your 
embroidery project.

Importing and rotating a patternStep 1

Duplicating a patternStep 2

Flipping a patternStep 3

Arranging patternsStep 4
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Practical Application a
Floral wreath – Arranging stitch patterns –

Step 1

Importing and rotating a pattern

1 In the [Import] pane, select [Design 
Library] from the [From] selector, 
then [Floral2] from the [Category] 
selector.

2 Select [33100110.pes] from the list of 
patterns displayed in the pane, and 
then drag it into the [Design Page].

3 While holding down the <Shift> key, 
drag the red dot at the top of the 
pattern to the right to rotate the 
pattern 90° clockwise (a).

Holding down the <Shift> key while 
dragging the red dot rotates the pattern 
in 15° increments.

a
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Practical Application a
Floral wreath – Arranging stitch patterns –
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Step 2

Duplicating a pattern

1 As in "Step 1", import pattern 
[33103503a.pes] from the [Floral2] 
category in the [Import] pane.

2 After selecting the pattern, click 
[Duplicate] in the [Clipboard] group 
to duplicate the pattern.

The [Duplicate] command can also be 
selected from the menu that appears 
after right-clicking the selected pattern.

 The duplicate appears, overlapping 
the original pattern and offset down 
and to the right.

\ 3 Rotate the original pattern 60° 
counterclockwise (b).

b
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Practical Application a
Floral wreath – Arranging stitch patterns –

Step 3

Flipping a pattern

1 After selecting the duplicate pattern, 
click [Rotate/Flip] in the [Edit] group, 
select [Flip Horizontally] under 
[Flip].

The [Flip] command can also be 
selected from the menu that appears 
after right-clicking the selected pattern.

 The selected pattern is flipped 
horizontally.

2 Rotate the flipped pattern 90° 
clockwise (c).

c
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Practical Application a
Floral wreath – Arranging stitch patterns –
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Step 4

Arranging patterns

1 Arrange the imported patterns to 
create a circle as shown in the figure 
(left), using the [Duplicate], [Rotate] 
and other [Arrange] commands.

2 Select [no77_2.pes] in the [Lace & 
Ribbon] category of the [Import] 
pane, and then drag it below the 
flower patterns.

a

b
c

a’

c’

b’
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Practical Application b
Team Jersey numbers – Combining text –

Practical Application b

Team Jersey numbers – Combining text –

About text patterns

130 built-in fonts are available in text pattern. Most of them can be divided 
into blocks according to the shape of the character, and the sewing 
direction is different for each block. This allows the patterns to appear 
more like three-dimensional and manual embroidery. Their shape consist 
of a line (outline) and a region (inside area), each of which can be set to a 
different sew type and color.

Entering textStep 1

Changing text color and sew typeStep 2

Importing transformed textStep 3

Aligning patternsStep 4
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Practical Application b
Team Jersey numbers – Combining text –
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Step 1

Entering text

1 In the [Import] pane, select [Text] 
from the [From] selector, then [Serif 
Fonts] from the [Category] selector.

2 Select [TN_001.pes] (Serif 01), and 
then drag it into the [Design Page].

3 Click the [Text Attributes] tab.

4 After clicking in the text field to enter 
input mode, delete the text "TEXT", 
type in "10", and then press the 
<Enter> key.

5 After selecting the text "10", click 
the [Text] ribbon tab.

6 Click the down arrow to the right of 
the [Text Size] selector in the [Font] 
group, and then select "30.0" from 
the list.
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Practical Application b
Team Jersey numbers – Combining text –

Step 2

Changing text color and sew type

1 Click the [Text Outline Sew Type] 
selector in the [Sew] group, and then 
click [Zigzag Stitch] in the list.

2 Click the [Color] tab, select the 
[Line] check circle, and then click 
[To list mode] at the bottom of the 
pane.

 The [Color] pane in thread list 
mode appears.
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Practical Application b
Team Jersey numbers – Combining text –
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3 Select [Blue] from the list.

4 Select the [Region] check circle in 
the [Color] pane, and then select 
[Pro Red] in the color palette.
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Practical Application b
Team Jersey numbers – Combining text –

Step 3

Importing transformed text

1 In the [Import] pane, select 
[Transformed] from the [Category] 
selector.

2 Select [TT_001.pes] (arched text), 
and then drag it into the [Design 
Page].

3 Click the [Text Attributes] tab.

4 After clicking in the text field to enter 
input mode, retype in "TEAM" and 
then press the <Enter> key.

5 After selecting the text "TEAM", 
click the [Text] ribbon tab.

6 As in "Step 2", select [Triple Stitch] 
from the [Text Outline Sew Type] 
selector in the [Sew] group and [Pro 
Red] as the line color.

7 Select [Blue] as the region color.

8 After selecting the text "TEAM" with 
the [Select] tool, hold down the 
<Shift> key and drag a black dot in a 
corner of the pattern to enlarge the 
pattern to the desired size.
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Practical Application b
Team Jersey numbers – Combining text –
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Step 4

Aligning patterns

9 Drag  to adjust the radius of the 
circle that the text is formed on.

1 Drag the pointer to draw a selection 
frame around the patterns "TEAM" 
and "10" to be selected.

2 Click the [Home] tab.

3 Click [Arrange] in the [Edit] group, 
and then click [Center] under 
[Horizontal].
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Practical Application c
Emblem – Using the Template wizard –

Practical Application c

Emblem – Using the Template wizard –

Using the wizard

Step 1

Starting the wizard

Wizards for importing photos and using design templates can be started 
from the startup wizard that appears after the application is started, and 
wizards for creating appliqués and patches can be started from the 
[Home] tab in the main window of [Layout & Editing]. By following the 
application instructions to enter the necessary information, even a 
beginner can create a high-quality finished project.

1 In the [Import] pane, select 
[Template] from the [From] selector, 
then [Sample] from the [Category] 
selector.

 Thumbnails of the templates in the 
selected category appear.

2 Select the thumbnail 
[TP_emblem01.pes], and then click 
[Template Wizard].

 The [Template Wizard] starts up.

Starting the wizardStep 1

Editing the textStep 2

Outputting the design dataStep 3
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Practical Application c
Emblem – Using the Template wizard –
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Step 2

Editing the text

Step 3

Outputting the design data

1 Click "SUMS" in the text edit box, 
and then click [Edit Text].

 The text "SUMS" is highlighted and 
can be edited.

2 Use the keyboard to type "N.U.H.S", 
and then press the <Enter> key.

 The text "since 1831" in the second 
row is highlighted and can be 
edited.

3 Use the keyboard to type "since 
1914", and then press the <Enter> 
key.

 The new text appears in the 
preview on the left side of the dialog 
box.

4 Click [Next].

 The [Output] dialog box appears.

1 Click the [Send to] selector to select 
where to output the data, and then 
click [USB Media] in the appropriate 
drive.

2 Click [Send].

 The data for the template design is 
copied to the selected USB media, 
and then the message "Finished 
outputting data." appears.

3 Click [OK].

Transfer the data to an embroidery 
machine to sew your project.
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Practical Application d
Photo embroidery - Creating an embroidery pattern from a photo -

Practical Application d

Photo embroidery - Creating an embroidery 
pattern from a photo -

Converting an image to an embroidery pattern

Step 1

Selecting an area of photo and tuning color of photo

You can create embroidery patterns from image data such as photos. 
Further customize the embroidery pattern by selecting the area of the 
photo to be embroidered, adjusting the color and brightness, 
changing the pattern size according to the embroidery hoop, or 
adding characters and other patterns. 
In this example, we will use your favorite photo, etc., to create an 
original embroidery pattern, which can directly be used with your 
embroidery machine.

1 On the [Image] tab, click [Open] in 
the [Image] group, and then select 
[from File] under [Open Image].

 The [Open an image file] dialog 
box appears.

Selecting an area of photo and tuning color of 
photoStep 1

Adjusting the embroidery hoop size and pattern 
sizeStep 2

Adjusting the color and brightnessStep 3

Adding textStep 4
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Practical Application d
Photo embroidery - Creating an embroidery pattern from a photo -
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2 Select [shh_gesture.jpg] that is 
located at Documents (My 
documents)\Palette Ver.11\
Sample\Layout & Editing\Photo 
Stitch, and then click [Open].

 The selected photo appears in the 
[Design Page].

3 Click [Photo Stitch 1] in the [Stitch 
Wizard] group, and then click 
[Color].

 The [Select Mask] dialog box 
appears.

4 Click [Image Tune].

5 Adjust the sharpness, brightness, 
contrast and color saturation.

For this example, increase the 
saturation by dragging the saturation 
slider to the third setting from the right, 
and then click [OK].
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Practical Application d
Photo embroidery - Creating an embroidery pattern from a photo -

Step 2

Adjusting the embroidery hoop size and pattern size

6 Click .

 The [Clipping Mask] dialog box 
appears, and an image mask is 
automatically created. The mask 
appears as the blue shading over 
the girl.

7 To use this image mask, click [OK].

To adjust the image mask, use the 
tools at the top of the dialog box, and 
then click [OK].

1 Click [Next].

 The [Check Mask Shape/Modify 
Image] dialog box appears. 
The area outside of the image mask 
appears as .
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Practical Application d
Photo embroidery - Creating an embroidery pattern from a photo -
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2 Click [Design Settings].

 The [Design Settings] dialog box 
appears.

3 On the [Design Page] tab, select [240 
x 360 mm] under [Page Size], and 
then click [OK].

Select an embroidery hoop size that fits 
the size of the created pattern.

 The [Check Mask Shape/Modify 
Image] dialog box appears again, 
and a [Design Page] with the new 
embroidery hoop size appears.

4 Click [Fit to page].

 The size of the image is adjusted to 
fill the selected embroidery hoop.
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Practical Application d
Photo embroidery - Creating an embroidery pattern from a photo -

Step 3

Adjusting the color and brightness

1 Click [Next].

 A preview of the image converted to 
an embroidery pattern appears.

2 Select the thread chart to be used 
from the [Thread Chart] selector.

Adjust the parameters in the windows 
as desired.

After adjusting the parameters, click 
[Update Preview] to update the 
preview.

3 Click [Select from Candidates].
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Practical Application d
Photo embroidery - Creating an embroidery pattern from a photo -
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4 Select one of the automatically    
adjusted patterns that appeared (1),  
and then click [OK] (2).

5 Check the adjusted color tones, and 
then click [Finish].

 The embroidery pattern is created.

a

b
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Practical Application d
Photo embroidery - Creating an embroidery pattern from a photo -

Step 4

Adding text

1 On the [Home] tab, click [Text] in the 
[Tools] group, and then select [Text] 
under [Text Tools].

2 On the [Text] tab, select [002 Script 
01] from the [Font] selector, and 
select [20.0] from the [Text Size] 
selector.

3 Click below the image in the [Design 
Page], type "2000.01.01", and then 
press the <Enter> key.

4 Specify the following settings for the 
text.

Region sew type Fill Stitch

Region color Pro Gold
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Practical Application e
Heart pattern – Changing the stitching for each shape pattern –
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Practical Application e

Heart pattern – Changing the stitching for 
each shape pattern –

About region sew types

Step 1

Importing an outline shape

The sew type for areas within closed outlines of text patterns or shapes 
can be specified. You can create both gorgeous and simple projects just by 
selecting the desired sew type from a list. The application includes 
patterned and motif stitches that can be customized using the 
[Programmable Stitch Creator].

1 In the [Import] pane, select [Outline 
Shapes] from the [From] selector, 
then [Events] from the [Category] 
selector.

2 Select pattern [OL_heart01.pes], and 
then drag it into the [Design Page].

Importing an outline shapeStep 1

Applying decorative fill stitches to a shapeStep 2

Applying programmable stitches to a shapeStep 3

Applying motif stitches to a shapeStep 4
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Practical Application e
Heart pattern – Changing the stitching for each shape pattern –

Step 2

Applying patterned stitches to a shape

1 Click any open space on the screen 
to unselect all items.

2 While holding down the <Ctrl> key, 
click the line (frame 2) and region 
(frame 1) of the largest heart pattern 
arranged in the [Sewing Order] pane.

3 Click  at the top of the [Sewing 
Order] pane.

4 Click the [Shapes] ribbon tab.

5 Click the [Region sew type] selector 
in the [Sew] group, and then select 
[Decorative Fill Stitch] in the list.

6 Click the [Line sew type] selector in 
the [Sew] group, and then select 
[Chain Stitch] in the list.

7 Click the [Color] tab, and then 
switch the pane to thread list mode.

8 Select [Line], and then click [Baltic 
Blue] in the color list.
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Practical Application e
Heart pattern – Changing the stitching for each shape pattern –
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Step 3

Applying programmable stitches to a shape

9 Click the [Sewing Attributes] tab. 
Switch the pane to expert mode, and 
then specify the following settings.

■ Line sew

Stitch Type

Size 3.0 mm

Time 5 times

Arrange

Start/End Type Feed

■ Region sew

Decorative fill 
pattern

df_pat002

Pattern Height 50.0 mm

Pattern Width 50.0 mm

Minimize Feed (ON)

Direction 0 degree

Run pitch 2.0 mm

Random Shift 0 %

1 Select the second-largest heart 
pattern (frames 3 and 4) in the 
[Sewing Order] pane.

2 Set a color and sew type for each 
shape as follows.

Line sew type
Candlewicking 
Stitch

Line color Jay Blue

Region sew type Prog. Fill Stitch
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Practical Application e
Heart pattern – Changing the stitching for each shape pattern –

3 Click the [Sewing Attributes] tab, 
and then specify the following 
settings.

■ Line sew

Density Medium

Size 3.0 mm

Spacing 1.0 mm

Start/End Type Feed

■ Region sew

Under sewing , Medium

Density 4.5 line/mm

Direction
Manual straight 
line, 
135 degrees

Running Stitch 
Path

Pull compensation 0.0 mm

Programmable fill

Click , select the desired 
pattern in the [Browse] dialog box, 
and then click [OK]. For this 
example, select [stamp1].

Fill stitch pattern stamp1 

Pattern height 7.5 mm

Pattern width 7.5 mm

Direction 0 degree

Offset row, 0 %
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Practical Application e
Heart pattern – Changing the stitching for each shape pattern –
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Step 4

Applying motif stitches to a shape

1 Select the smallest heart pattern 
(frames 5 and 6) in the [Sewing 
Order] pane.

2 Click the [Shapes] tab.

Line sew type Stem Stitch

Line color
Purple 
Shadow

Region sew type Motif Stitch

3 Click the [Sewing Attributes] tab, 
and then specify the following 
settings.

■ Line sew

Width 2.0 mm

Spacing 1.5 mm

Angle 45 degrees

Stitch Type  (Triple)

Start/End Type Feed

■ Region sew

Motif pattern motif074 

Motif Pattern1 only

Motif height 10.0 mm

Motif width 9.5 mm

H-Arrange

V-Arrange

H-Offset 0.0 mm

V-Offset 1.0 mm

H-Spacing 0.0 mm

V-Spacing -6.0 mm
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Practical Application f
Bird of peace – Applying gradation to a vector image –

Practical Application f

Bird of peace – Applying gradation to a 
vector image –

Creating embroidery patterns using images

Step 1

Importing vector images (SVG files)

An embroidery pattern can be created from an image, such as photo or 
illustration. Use the [Import from Vector Image] command for converting 
WMF, EMF and SVG image files to embroidery patterns. The various 
[Stitch Wizard] functions are also available to create embroidery patterns 
from BMP, JPG and PNG image files.

1 Click the [Home] tab.

2 Click [Import Patterns] in the 
[Import] group, and then select [from 
Vector Image] in the menu.

 The [Open a vector file] dialog box 
appears.

Importing vector images (SVG files)Step 1

Displaying hidden objectsStep 2

Decorating the outer heart shapeStep 3

Applying gradationStep 4
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Practical Application f
Bird of peace – Applying gradation to a vector image –
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Step 2

Displaying hidden objects

3 Select the file to be imported, and 
then click [Open].

For this example, we will import 
[svg_heart.svg].

 The image appears in the [Design 
Page] as a shape pattern.

1 Click  in the toolbar at the top of 
the [Sewing Order] pane, and then 
click [Hide Objects Not Stitched] in 
the menu.

 Hidden objects that are not to be 
stitched appear in the pane.
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Practical Application f
Bird of peace – Applying gradation to a vector image –

Step 3

Decorating the outer heart shape

1 Select the colored area of the heart 
shape, and then click [Shapes] tab.

2 Specify a color and sew type for 
each shape as follows.

Line sew type Motif Stitch

Line color Salmon

Region sew type
Prog. Fill 
Stitch

Region color Begonia

3 Click the [Sewing Attributes] tab. 
Switch the pane to expert mode, and 
then specify the following settings.

■ Line sew

Motif pattern motif063 

Motif height 4.5 mm

Motif width 4.5 mm

H-Arrange

V-Arrange

Offset 0.0 mm

Spacing 0.0 mm

Run pitch 5.0 mm

Start/End Type Feed

■ Region sew

Under sewing , 
Medium

Density 4.8 line/mm

Direction
Manual 
straight line, 
45 degrees

Running Stitch Path

Pull compensation 0.0 mm

Programmable fill

Pattern pat13 

Pattern height 6.0 mm

Pattern width 6.0 mm

Direction 0 degree

Offset row, 0 %
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Practical Application f
Bird of peace – Applying gradation to a vector image –
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Step 4

Applying gradation

1 Move the pointer into the [Sewing 
Order] pane and drag it to draw a 
selection frame around all the inner 

patterns, and then click  at the 
top of the pane.

2 Specify a color and sew type for 
each shape as follows.

Region sew type Fill Stitch

Region color Ice Blue

3 Select the [Gradation] check box, 
and then click [Pattern].

 The [Gradation Pattern Setting] 
dialog box appears.

4 Select the [Blend] check box on the 
right side of the dialog, and then 

click  (top).

 The thread color list appears.
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Practical Application f
Bird of peace – Applying gradation to a vector image –

5 Select the color to be used in the 
two-color gradation, and then click 
[OK].

For this example, select [Natural 
White].

6 Specify the following settings using 
the right side of the [Gradation 
Pattern Setting] dialog box.

Density 4.8 line/mm

Direction 0 degree

7 Select  for gradation pattern, 
and then click [OK].

8 In the [Sewing Order] pane, drag 
frame 2 (heart shape outline) to the 
top (above the outer heart shape).
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Practical Application g

Symbol – Specifying the sewing direction 
for each separate shape –

Changing sewing direction

Step 1

Splitting patterns

When closed regions are created using [Shapes] tools, a uniform sewing 
direction, indicated by a sewing direction line (red arrow or red curve line), 
is applied to the entire region. The direction line can be edited by moving 
the end points, or new sewing direction lines can be added. 

The direction line can also be changed into a curve, whose shape can be 
arranged by dragging points on it.

Try various sewing directions and curve shapes to find the optimum setting 
for the pattern shape.

1 Click  at the bottom-right of the 
screen to switch to the [Stitch View] 
mode.

Splitting patternsStep 1

Setting a sewing directionStep 2

Optimizing the sewing orderStep 3

Grouping pattern partsStep 4
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Symbol – Specifying the sewing direction for each separate shape –

2 Click the [View] tab, and then select 
the [Reference Window] check box 
in the [Show/Hide] group.

 The [Reference Window] appears.

3 In the [Import] pane, select [Outline 
Shapes] from the [From] selector, 
then [Emblems] from the [Category] 
selector.

4 Select pattern 
[OL_fleur_de_lys01.pes], and then 
drag it into the [Design Page].

 If necessary, enlarge or reduce the 
pattern to an easy-to-edit size.

5 Select the pattern using the [Select] 
tool, and then click the [Shapes] tab.

6 Click the [Line sew type] selector in 
the [Sew] group, and then click [Not 
Sewn (Line)] in the list.

 The outline is removed.

7 Click  in the [Reference Window].

8 Drag the pointer in the window to 
draw a display area frame around 
the desired part of the pattern to 
zoom to.

 The selected display area is 
enlarged in the [Design Page].

a

b
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9 Select the pattern, and then click 
[Split Outline] in the [Tools] group of 
the [Shapes] tab.

 The mode for specifying splitting is 
entered. In this mode, a section of 
the pattern can be split off by 
enclosing it in a polygon.

10 Click in the [Design Page] to create a 
polygon that encloses the area of 
the pattern to be split off.

The polygon will appear with the first 
clicked point as the beginning of the 
polygon and subsequent clicked points 
as vertices. For this example, we will 
enclose the middle section of the 
pattern with a polygon in order to split it 
off.

b
• A section of pattern cannot be split off and an error message appears, if a polygon has intersecting lines.

• Right-click to cancel the previous point that was clicked.

• By displaying the pattern enlarged, the area to be split off can be selected more accurately.

11 Double-click on the final vertex (f) 
of a polygon to confirm the 
displayed polygon as the area to be 
split off.

 The single shape is split into three 
parts, which appear in the [Sewing 
Order] pane.

a

f

b

d

c

e
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Symbol – Specifying the sewing direction for each separate shape –

Step 2

Setting a sewing direction

12 After selecting the upper section 
from the three pattern parts, repeat 

steps 8 through 11 to split off the 
center section.

13 After selecting the lower section 
from the five pattern parts, repeat 

steps 8 through 11 to split off the 
center section.

1 Click [Select] in the [Select] group, 

and then click  (Select Point).

f g

he

d i

c j

b k

a

a

g b

f c

e d
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2 Select the middle section of the 
pattern that was first split off.

 The selected pattern is displayed in 
shape editing mode, and the points 
forming the shape as well as the 
sewing direction line (arrow) 
appear.

3 Click the [Sewing Attributes] tab. 
Select [Manual straight line] under 
[Direction], and then type "90" in the 
input box to set the sewing angle.

4 Using , select the upper-right 

section of the pattern.

5 Click the [Sewing Attributes] tab. 
Select [Manual curve] under 
[Direction].
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Symbol – Specifying the sewing direction for each separate shape –

6 Drag each point on the direction line 
(red curve) to specify your desired 
curve of sewing for the right side of 
the pattern part.

7 Repeat steps 4 through 6 to specify 
the sewing directions for the upper-
left section of the pattern.

8 Using , select the lower-right 

section of the pattern.

9 Drag each end of the direction line 
(arrow) to specify the sewing 
direction.

The sewing direction is specified from 
the end to the point of the direction line.

10 Click the [Shapes] tab, and then 
click [Add Direction Line] in the 
[Sewing Direction Line] group.

 A direction line (arrow) for 
specifying the sewing direction can 
be added.
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11 Click below the end (red square) of 
the first arrow (1), and move the 
pointer across the pattern part, and 
then click again right of the pattern 
part (2).

 The second direction line appears 
between the two clicked points.

12 Repeat steps 8 through 11 to 
specify the sewing directions for the 
lower-left section of the pattern.

a

b
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Symbol – Specifying the sewing direction for each separate shape –

Step 3

Optimizing the sewing order

Step 4

Grouping pattern parts

1 In the [Sewing Order] pane, change 
the sewing order by dragging the 
frames to the desired positions. 

For this example, change the order as 
shown in the figure left.

2 In the [Sewing Order] pane, drag the 
pointer to draw a selection frame 
around all the pattern parts.

3 Click  at the top of the [Sewing 
Order] pane to automatically 
optimize the sewing order.

b
Find the most efficient sewing order by viewing the pattern in the [Design Page] in [Stitch View] mode to 
check the stitching or by previewing the stitching with the [Stitch Simulator].

1 Select , and then drag the pointer 
in the [Design Page] to draw a 
selection frame around the entire 
pattern.

2 Click [Group] in the [Edit] group, and 
then click [Group] in the menu.

By grouping multiple patterns, they can 
be enlarged/reduced or rotated 
together in a single operation.

a

g

b

f

c

e

d
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Practical Application h

Icon design - Creating an original design by 
combining shapes -

Arranging multiple overlapping shapes

Step 1

Arranging shapes to create an outline

Use multiple shapes to create a custom design. You can combine two 
or more overlapping shapes into a single design and prevent 
overlapping stitching of overlapping regions within the design (in 
other words, one overlapping region is removed from the other).

1 In the [Import] pane, select [Outline 
Shapes] from the [From] selector, 
then [Basic Shapes] from the 
[Category] selector.

Arranging shapes to create an outlineStep 1

Merging overlapping shapesStep 2

Preventing overlapping stitching of overlapping 
shapesStep 3
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2 Select pattern [BS_shapes02.pes], 
and then drag it into the [Design 
Page].

You can also select shapes by clicking 
[Shapes] in the [Tools] group on the 
[Home] tab.

3 Adjust the shape as shown to draw 
the camera body.

a While holding down the <Shift> key, 
drag the handle at the center of the 
right side to the right in order to enlarge 
the shape equally to both the left and 
right.

b Drag the handle at the center of the top 
edge up in order to increase the height.

4 On the [Home] tab, click [Select] in 
the [Select] group, and then click 

 (Select Point).

5 Click three places on the top edge of 
the rectangle, as shown, to add 
points.

b

a
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6 Use  to select the point at the 
center of the top edge, and then, 
while holding down the <Shift> key, 
drag the point straight up.

7 With the moved point selected, click 
[Edit Point] in the [Edit Point] group 
on the [Shapes] ribbon tab, and then 
select [To Curve] under [Line Type].

 The outline sections on the left and 
right sides of the point become 
curved.

8 Display the [Import] pane, and then 
drag [BS_shapes02.pes] into the 
[Design Page] twice.

9 Adjust the size, shape and 
arrangement of the pattern.
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Icon design - Creating an original design by combining shapes -

Step 2

Merging overlapping shapes

1 Drag the pointer to draw a selection 
frame around all shapes to select 
them.

2 Specify the following settings for the 
sew types and colors of the object.

Line sew type Zigzag Stitch

Region sew type Fill Stitch

Line color Black

Region color Black

3 In the [Home] tab, click [Modify 
Overlap] in the [Edit] group, and 
then select [Merge] under [Remove/
Merge].
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Step 3

Preventing overlapping stitching of overlapping shapes

 All shapes are merged together into 
one.

1 Import [BS_shapes01.pes] from the 
[Import] pane, and then adjust its 
size and position, as shown.

2 Specify the following settings for the 
sew types and colors of the circle.

Line sew type Zigzag Stitch

Region sew type Fill Stitch

Line color Black

Region color Natural White
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3 In the [Sewing Attributes] pane, set 
[Manual straight line] under 
[Direction] to "135" degrees.

4 Select both shapes.

5 In the [Home] tab, click [Modify 
Overlap] in the [Edit] group, and 
then select [Set hole sewing] under 
[Hole sewing].

 The overlapping area of the two 
shapes will not be sewn twice (only 
the inner circle will be sewn). This is 
called hole sewing.

6 Add [BS_shapes01.pes] to the 
center of the white circle, and then 
specify the following settings for the 
sew types, colors and angle.

Line sew type Zigzag Stitch

Region sew type Fill Stitch

Line color Black

Region color Black

Direction
Manual 
straight line, 
90 degrees
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7 In the [Sewing Order] pane, hold 
down the <Shift> key, and click 
frame 3 (a), then frame 6 (b).

 Frames 3, 4, 5 and 6 are selected.

8 Click  (c).

 The two circles are selected.

9 Apply hole sewing to the two 
selected circles as described in 

step 5.

10 Arrange the smaller circle inside the 
black circle, and then specify the 
following settings.

Line sew type Zigzag Stitch

Region sew type Fill Stitch

Line color Black

Region color Natural White

Direction
Manual 
straight line, 
0 degree

11 Repeat steps 7 and 8 to select the 
innermost circle and the black circle 
immediately outside of it.

12 Apply hole sewing to the two 
selected circles as described in 

step 5.

c

a

b





Lea este apartado antes de instalar 
este software
Gracias por adquirir este software. Antes de instalar este software, lea detenidamente el siguiente acuerdo 
relativo a este producto. Utilice este software únicamente si acepta los términos del acuerdo. La instalación 
de este software implica la aceptación de las condiciones de uso.

Acuerdo del producto

Algunas partes de este producto han sido creadas usando tecnología de Softfoundry International Pte. Ltd.

1) Condiciones generales
Éste es un acuerdo entre usted (el usuario final) y nuestra empresa relativo a este producto.

2) Uso de este producto
Únicamente podrá instalar y utilizar este producto en un solo ordenador.

3) Limitaciones en cuanto a duplicaciones
No podrá duplicar este producto, excepto para realizar copias de seguridad.

4) Limitaciones en cuanto a modificaciones
En ningún caso podrá desmontar ni modificar este producto.

5) Limitaciones en cuanto a cesiones
Este software no podrá ser cedido ni usado de ninguna otra manera por terceras personas.

6) Garantía
No aceptamos ninguna responsabilidad relacionada con su elección, uso del producto o los daños 
que puedan aparecer por el uso.

7) Otros
Este producto está protegido por las leyes de copyright.



INFORMACIÓN IMPORTANTE: 
NORMATIVAS

Comisión Federal de Comunicaciones (FCC) 
Declaración de conformidad (sólo para EE.UU.)

declara que el producto

cumple la sección 15 de las normas de la FCC. El funcionamiento está sujeto a las dos condiciones 
siguientes: (1) este dispositivo no debe causar interferencias perjudiciales, y (2) este dispositivo debe 
aceptar cualquier interferencia recibida, incluidas interferencias que puedan causar un funcionamiento no 
deseado.

Este equipo ha sido probado y se determina que cumple con los límites para dispositivos digitales de Clase 
B, de conformidad con la Parte 15 de las reglas de la FCC. Estos límites están diseñados para proporcionar 
una protección razonable contra interferencias perjudiciales en instalaciones residenciales. Este equipo 
genera, usa y puede irradiar energía de radiofrecuencia y, si no se instala y utiliza tal y como indican las 
instrucciones, puede causar interferencias perjudiciales en las comunicaciones por radio. No obstante, no 
existe ninguna garantía de que no pueda haber interferencias en una instalación en particular. Si este equipo 
provoca interferencias perjudiciales en la recepción de radio o televisión, lo que se puede determinar 
apagando y volviendo a encender el equipo, el usuario puede intentar corregir la interferencia adoptando 
una o varias de las siguientes medidas:

- Vuelva a orientar o colocar la antena receptora.
- Aumente la separación entre el equipo y el receptor.
- Conecte el equipo a una toma en un circuito diferente al que está conectado el receptor.
- Solicite ayuda al vendedor o a un técnico de radio/TV cualificado.

Importante

Los cambios o modificaciones que Tacony Corporation no haya autorizado expresamente podrían anular la 
autorización del usuario para utilizar el equipo.

Responsible Party: Tacony Corporation
1760 Gilsinn Lane
Fenton MO 63026 USA

Product Name: Baby Lock Palette Software Key

Model Numbers: ECS11



Le felicitamos por la elección de nuestro producto
Le agradecemos la compra de nuestro producto. Para obtener el mejor rendimiento de esta unidad y garantizar un funcionamiento 
correcto y seguro, lea detenidamente este documento y, a continuación, guárdelo en un lugar seguro junto a la garantía.

Lea este manual antes de utilizar este producto

Para crear bonitos diseños de bordado
Este sistema permite crear una amplia variedad de diseños de bordado y admite un límite más amplio de 
configuración de atributos de costura (densidad del hilo, punto de costura, etc.). No obstante, el resultado 
final depende del modelo de máquina de coser particular. Se recomienda hacer una prueba de muestra de 
costura con los datos de costura antes de coser en el material final.

Para un funcionamiento seguro
• No guarde archivos en la “Llave de software Palette (Palette Software Key)” para transferirlos o almacenarlos.
• No conecte la “Llave de software Palette (Palette Software Key)” a la máquina de bordar.

Para un funcionamiento más duradero
• Cuando almacene la “Llave de software Palette (Palette Software Key)”, evite exponerla directamente a la 

luz del sol y guardarla en lugares con una humedad elevada. No almacene la “Llave de software Palette 
(Palette Software Key)” cerca de un calefactor, una plancha u otros objetos calientes.

• No derrame agua u otros líquidos en la “Llave de software Palette (Palette Software Key)”.
• No deje caer ni golpee la “Llave de software Palette (Palette Software Key)”.

Para ajustes o reparaciones
En el caso de que se produzca una avería o se requiera un ajuste, póngase en contacto con su distribuidor Baby Lock.

Aviso
Esta Guía de referencia y el Manual de instrucciones no explican cómo utilizar el ordenador en Windows®. 
Consulte los manuales de Windows®.

Marcas comerciales
• Windows® es una marca comercial registrada de Microsoft Corporation.
• Los otros nombres de productos mencionados en la Guía de referencia y en el Manual de instrucciones 

pueden ser marcas comerciales o marcas comerciales registradas de sus respectivos propietarios, y de 
este modo lo hacemos constatar.

Importante
El uso de esta unidad para la copia no autorizada de material de los datos de bordado, periódicos y revistas 
para fines comerciales va en contra de la ley de copyright y está penado por la ley.

Precaución
El software incluido en este producto está protegido por las leyes de copyright. Este software se puede 
utilizar o copiar sólo de conformidad con las leyes de copyright.

Si desea información adicional acerca de productos y actualizaciones, visite nuestro sitio web:
www.babylock.com

CONSERVE ESTAS INSTRUCCIONES
Este producto ha sido diseñado para uso doméstico.
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Primeros pasos

Crear el patrón
de bordado

deseado

Convertir sus
ideas en

bordados

Crear distintos
diseños de

bordado

2

Consultar esta guía para obtener 
mejores resultados

Pasos para la instalación
Siga estos pasos iniciales 
para instalar el software.

Para usuarios que desean 
aprender las operaciones 
básicas de la aplicación
Soy/estoy...

.... un usuario principiante de 
Palette.

.... interesado en revisar las 
operaciones básicas.

Para usuarios que desean 
empezar inmediatamente a 
crear patrones
Soy/estoy...

.... un usuario intermedio/
avanzado de Palette.

.... interesado en aprender las 
operaciones para aplicaciones 
específicas y los detalles de la 
operación.
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Cómo utilizar los manuales

Guía de referencia (libro impreso/formato PDF)
Lea esta guía antes de utilizar el software. La guía comienza con los procedimientos para instalar el software 
e incluye precauciones y consejos para utilizar este software. La segunda mitad contiene multitud de 
tutoriales que explican funciones básicas para crear patrones de bordado, así como ejemplos de proyectos.
• Sección de instalación

1) Lea la información acerca de cómo comprobar el contenido del paquete y la preparación de la 
instalación. (c página 5)

2) Instale el software siguiendo las instrucciones. (c página 6)
3) Conozca la información de soporte del software y el registro en línea. (c página 13)

• Sección de funcionamiento básico
1) Conozca los aspectos clave para crear patrones de bordado. (c página 15)
2) Conozca las funciones y operaciones de pantalla básicas. (c página 17)
3) Pruebe a crear proyectos de ejemplo. (c página 28)

• Símbolos utilizados en la guía

Manual de instrucciones
El manual explica las funciones y operaciones, así como diversos ajustes de Palette, para cualquier nivel de 
conocimientos, desde principiantes hasta usuarios avanzados.

■ Manual de instrucciones online
Está disponible un Manual de instrucciones online, al que también puede accederse desde un dispositivo móvil. 
Babylock.com/palette11/es

Consultar desde la pantalla [Inicio] (para usuarios de Windows® 10)
Haga clic en . Haga clic en [Palette Ver.11] y luego seleccione [Manual de instrucciones online].

Consultar desde la aplicación
Haga clic en [Ayuda] en la ventana de cada aplicación. En [Design Database], [Ayuda] se 
encuentra en la barra de menús de la parte superior de la ventana.

En otras aplicaciones, se encuentra en la esquina superior derecha de la ventana.

a : Indica precauciones que deben observarse durante las operaciones de software. Esta información 
es necesaria para un buen funcionamiento, por lo que siempre que vea esta marca debe leerla.

b : Indica consejos útiles acerca del funcionamiento. Si comprende estas explicaciones, la creación 
de patrones de bordado será más sencilla y agradable.

b
• Para usuarios de Windows® 8.1: Coloque el puntero del ratón en la pantalla [Inicio] para mostrar la 

flecha hacia abajo en la esquina inferior izquierda de la pantalla (en la parte inferior izquierda de los 
mosaicos), y haga clic.
En la lista de aplicaciones que aparece en pantalla, haga clic en [Manual de instrucciones online] 
debajo del título [Palette Ver.11].

• Para usuarios de Windows® 7: Haga clic en  y, a continuación, en [All Programs]. Haga clic en 
[Palette Ver.11] y luego seleccione [Manual de instrucciones online].
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b
• El Manual de instrucciones también está disponible en formato PDF para utilizarlo cuando su ordenador 

no está conectado a Internet.
• Puede accederse al Manual de instrucciones y a la Guía de referencia en formato PDF de la siguiente 

forma:
- Para usuarios de Windows® 10: Haga clic en . Haga clic en [Palette Ver.11] y luego seleccione 

[Manual de instrucciones] o [Guía de referencia].
- Para usuarios de Windows® 8.1: Coloque el puntero del ratón en la pantalla [Inicio] para mostrar la 

flecha hacia abajo en la esquina inferior izquierda de la pantalla (en la parte inferior izquierda de los 
mosaicos), y haga clic. 
En la lista de aplicaciones que aparece en pantalla, haga clic en [Manual de instrucciones] o en 
[Guía de referencia] debajo del título [Palette Ver.11].

- Para usuarios de Windows® 7: Haga clic en  y, a continuación, en [All Programs]. Haga clic en 
[Palette Ver.11], luego en [PDF] y seleccione [Manual de instrucciones] o [Guía de referencia].

• Se requiere Adobe® Reader® para ver e imprimir la versión PDF de los manuales.
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Primeros pasos

Introducción

Contenido del paquete (solo la versión completa)
Compruebe que no falte ninguno de los siguientes elementos. Si falta alguno o hay alguno dañado, póngase 
en contacto con su vendedor de Baby Lock.

Precauciones para utilizar la “Llave de software Palette 
(Palette Software Key)”
• Esta “Llave de software Palette (Palette Software Key)” es necesaria para ejecutar el software, por lo que 

si la pierde deberá volver a adquirir el software. Guárdela en un lugar seguro cuando no la utilice.
• La “Llave de software Palette (Palette Software Key)” impide el uso no autorizado de este software. El 

software no puede iniciarse si la “Llave de software Palette (Palette Software Key)” no está conectada.
• La “Llave de software Palette (Palette Software Key)” no puede utilizarse como un dispositivo USB. No guarde 

archivos de bordado en la “Llave de software Palette (Palette Software Key)” para transferirlos o almacenarlos.
• No conecte la “Llave de software Palette (Palette Software Key)” a la máquina de bordar.
• No formatee la “Llave de software Palette (Palette Software Key)”.
• No almacene la “Llave de software Palette (Palette Software Key)” en lugares con una humedad elevada ni 

la exponga a la luz directa del sol, la electricidad estática o impactos fuertes. Igualmente, no doble la 
“Llave de software Palette (Palette Software Key)”.

• Antes de la instalación, realice una copia de seguridad del instalador almacenado en la “Llave de software 
Palette (Palette Software Key)”.

• Si la aplicación instalada no funciona correctamente, vuelva a realizar la instalación.
• Si el ordenador no arranca con la “Llave de software Palette (Palette Software Key)” conectada, 

desconecte la “Llave de software Palette (Palette Software Key)” y luego active el ordenador. Vuelva a 
conectar la “Llave de software Palette (Palette Software Key)” para iniciar el programa.

Llave de software Palette 
(Palette Software Key)

Contiene el software
* El diseño está sujeto a cambios.

Guía de referencia 
(este manual)

Hoja de posicionamiento
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Instalación
Prim

eros pasos

Instalación

Lea lo siguiente antes de la instalación
• Antes de iniciar la instalación, compruebe que el ordenador cumpla todos los requisitos del sistema.
• Para instalar el software en el sistema operativo Windows®, deberá iniciar sesión en el ordenador 

utilizando una cuenta con privilegios de administrador. Si no inicia sesión con una cuenta de administrador, 
es posible que Windows® le solicite la contraseña de dicha cuenta. Escriba la contraseña para continuar 
con el procedimiento. Si desea información sobre cómo iniciar sesión en el ordenador utilizando una 
cuenta con privilegios de administrador, consulte el manual de Windows®.

• El procedimiento de instalación descrito es para Windows® 10. El procedimiento y los cuadros de diálogo 
para otros sistemas operativos pueden ser ligeramente diferentes.

• Si se cancela la instalación antes de tiempo o si el procedimiento no se realiza de la forma descrita, el 
software no se instalará correctamente.

• No retire la “Llave de software Palette (Palette Software Key)” del puerto USB del ordenador mientras se 
está realizando la instalación. Retire la “Llave de software Palette (Palette Software Key)” una vez 
completada la instalación.

Requisitos del sistema
Antes de instalar el software en el ordenador, asegúrese de que el ordenador cumple los siguientes 
requisitos mínimos.

Sistema operativo Windows® 7, 8.1, 10 (32 o 64 bits)

Procesador 1 GHz o más

Memoria 1 GB como mínimo

Espacio libre en el disco duro 600 MB

Monitor XGA (1024 × 768), color de 16 bits o superior

Puerto
Dos o más puertos USB (se utilizan para conectar la “Llave de software 
Palette (Palette Software Key)” y para transferir los datos de bordado a 
una máquina de bordar)

Dispositivo Ratón

Impresora Una impresora gráfica compatible con el sistema (si desea imprimir las 
imágenes)

Acceso a Internet Necesario para actualizar Palette

a
• Es posible que este producto no funcione correctamente en algunos ordenadores.
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Instalación

Procedimiento de instalación
En esta sección se describe cómo instalar el software de la aplicación.

a
• Antes de comenzar la instalación, siga este procedimiento para realizar una copia de seguridad del 

instalador en el ordenador.
1) Cree una carpeta para la copia de seguridad en el ordenador.
2) Copie toda la carpeta [Palette Ver.11] desde la “Llave de software Palette (Palette Software Key)” a 

la carpeta creada en el paso 1).
• No borre los datos de la carpeta [Palette Ver.11] de la “Llave de software Palette (Palette Software 

Key)”.

1 Conecte la “Llave de software 
Palette (Palette Software Key)” al 
puerto USB del ordenador.
→ Transcurridos unos instantes, se 

muestra automáticamente el 
cuadro de diálogo [Reproducción 
automática].

→ Los usuarios de Windows® 7 deben 
seguir el paso 3 cuando se 
muestre el cuadro de diálogo 
[Reproducción automática].

a
No desconecte ni conecte la “Llave de software Palette (Palette Software Key)” hasta que se haya 
completado la instalación.

b
Si el cuadro de diálogo [Reproducción automática] no se muestra automáticamente:
• Para usuarios de Windows® 10/8.1:

1) Haga clic con el botón derecho del ratón en  /  y seleccione [Ejecutar] en la lista de comandos.
* En Windows® 8.1, mueva el puntero sobre la esquina inferior izquierda de la pantalla para mostrar 

 y haga clic con el botón derecho del ratón en .
→ Se muestra el cuadro de diálogo [Ejecutar].

2) Escriba la ruta completa al instalador y luego haga clic en [Aceptar] para iniciar el instalador. 
Por ejemplo: E:\Palette Ver.11\setup.exe (donde “E:” es el nombre de la unidad utilizada para la 
“Llave de software Palette (Palette Software Key)”)

• Para usuarios de Windows® 7: 
Haga clic en  y luego en [All Programs]. Seleccione [Accesorios] y luego haga clic en [Ejecutar] 
para mostrar el cuadro de diálogo [Ejecutar]. Escriba la ruta completa al instalador en la ventana de 
entrada de datos.
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2 Haga clic en el mensaje que se 
muestra en la esquina inferior 
derecha de la pantalla.
→ Se continúa visualizando el cuadro 

de diálogo [Reproducción 
automática].

3 Haga clic en [Abrir carpeta para ver 
los archivos].
→ Se muestra la ventana [Explorador 

de archivos].

4 Abra la carpeta [Palette Ver.11] y 
haga doble clic en el archivo 
[setup.exe].
→ Se muestra el cuadro de diálogo 

[Control de cuentas de usuario].

5 Haga clic en [Sí].
→ Transcurridos unos instantes, se 

mostrará automáticamente el 
siguiente cuadro de diálogo.
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Instalación

6 Seleccione el idioma deseado y 
haga clic en [Siguiente].

7 Haga clic en [Siguiente] para 
continuar con la instalación.
→ Aparece el cuadro de diálogo del 

acuerdo de licencia.

8 Lea el acuerdo de licencia. Marque 
la casilla [Acepto los términos del 
contrato de licencia] si acepta los 
términos y haga clic en [Siguiente].
→ Aparece un cuadro de diálogo 

donde podrá seleccionar la carpeta 
en la que se instalará el software.

9 Compruebe la ubicación de la 
instalación y haga clic en [Instalar] 
para instalar la aplicación.
→ Una vez finalizada la instalación, 

aparece el siguiente cuadro de 
diálogo.

b
Para instalar la aplicación en una carpeta diferente:

1) Haga clic en [Cambiar].
2) En el cuadro de diálogo [Buscar carpeta] que se muestra, seleccione la unidad y la carpeta. (Si 

fuera necesario, escriba el nombre de una nueva carpeta).
3) Haga clic en [Aceptar].

→ El cuadro de diálogo [Carpeta Base de datos] del [InstallShield Wizard] muestra la carpeta 
seleccionada.

4) Haga clic en [Instalar] para instalar la aplicación en la carpeta seleccionada.
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10 Haga clic en [Finalizar] para 
completar la instalación del 
software.

b
• Reinicie el equipo si se muestra un mensaje indicando que debe hacerlo.
• Si se marca la casilla [Incia el Manual de instrucciones online], se abrirá el Manual de instrucciones 

online una vez completada la instalación.
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Instalación

Desinstalación del software

1 Haga clic en  y luego en .

2 Haga clic en [Aplicaciones].

3 En la ventana [Aplicaciones y 
características], seleccione [Palette 
Ver.11] y haga clic en [Desinstalar].
→ Se mostrará el mensaje [Se 

desinstalará esta aplicación y 
toda la información 
relacionada.].
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4 Haga clic en [Desinstalar].
Si aparece el mensaje [Control de 
cuentas de usuario], haga clic en [Sí].

b
• El procedimiento de desinstalación descrito es para Windows® 10.
• En Windows® 8.1, haga clic con el botón derecho en [Palette Ver.11 (Layout & Editing)] en la pantalla 

[Aplicaciones], y haga clic en [Desinstalar] en la barra de tareas de la parte inferior de la pantalla. 
Seleccione este software en la ventana [Programas y características] y haga clic en [Desinstalar].

• En Windows® 7, haga clic en el botón [Inicio] y luego en [Panel de control]. Seleccione [Programas y 
características] en la ventana [Panel de control]. Seleccione este software y luego haga clic en 
[Desinstalar].
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Servicio de Asistencia técnica/Soporte

Servicio de Asistencia técnica/Soporte

Servicio de Asistencia técnica
Si se produce algún problema, haga clic en [Ayuda] en la pantalla y seleccione [Servicio de atención al 
cliente] para consultar las “FAQ” (preguntas más frecuentes) en nuestro Servicio de atención al cliente 
(https://www.babylock.com/support/faq/), donde podrá encontrar respuestas a las preguntas más frecuentes, 
así como las posibles causas y soluciones a los problemas.

Póngase en contacto con el “Servicio de asistencia de los productos Baby Lock” si no encuentra la solución 
a su problema. Visite www.babylock.com y seleccione “Servicio de atención al cliente”.

Registro en línea
Si desea que le mantengamos informado sobre actualizaciones y le facilitemos información importante, 
como el desarrollo de nuevos productos y mejoras, puede registrar en línea su producto siguiendo el sencillo 
procedimiento que se indica a continuación.

Seleccione [Registro en línea] en el menú [Ayuda] de [Layout & Editing] para iniciar el explorador web 
instalado y abrir la página de registro en línea en nuestro sitio web.

www.babylock.com/register

a
Antes de ponerse en contacto con el sitio web:

1) Tenga el sistema operativo Windows® actualizado con la versión más reciente.
2) Localice la marca y el número de modelo del ordenador utilizado, así como la versión del sistema 

operativo Windows®.
3) Obtenga información acerca de cualquier mensaje de error que aparezca. Esta información le 

ayudará a agilizar la tramitación de sus consultas.
4) Compruebe el software y actualícelo a la versión más reciente.

a
Puede que el registro en línea no esté disponible en algunas zonas.
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Comprobar la versión más reciente del 
programa

1 Seleccione [Ayuda] en [Layout & 
Editing] y luego seleccione [Buscar 
actualizaciones].
→ Se comprueba el software para 

determinar si es o no la versión 
más reciente.

2 Si aparece el mensaje que se 
muestra a la izquierda, haga clic en 
[Aceptar].
Se está utilizando la versión más 
reciente del software.

3 Si aparece el mensaje que se 
muestra a la izquierda, haga clic en 
[Si] para iniciar la descarga de la 
versión más reciente del software 
desde el sitio web.

a
• Esta función no se puede utilizar si el ordenador no está conectado a Internet.
• Si está activado un cortafuegos, es posible que no se pueda buscar la versión más reciente. Desactive el 

cortafuegos e intente realizar la operación de nuevo.
• Se requieren privilegios de administrador.

b
Si la casilla de verificación [Buscar siempre la versión más actualizada al iniciar] está marcada, se 
comprueba el software al iniciarse para determinar si se está utilizando o no la versión más reciente.



À lire avant d’installer ce logiciel
Nous vous remercions d’avoir acheté ce logiciel. Avant d’installer ce logiciel, lisez attentivement l’accord de 
licence suivant, fourni avec ce produit. N’utilisez ce logiciel que si vous avez accepté les conditions 
générales de cet accord. En installant ce logiciel, vous en acceptez les conditions d’utilisation.

Accord de licence

Certains éléments de ce produit ont été créés à l’aide de la technologie de Softfoundry International Pte. Ltd.

Avis de conformité d’Industrie Canada (pour le 
Canada uniquement)
CAN ICES-3(B)/NMB-3(B)

1) Conditions générales
L’accord de licence de ce produit est un accord entre vous (l’utilisateur final) et notre société.

2) Utilisation du produit
Vous ne pouvez installer et utiliser ce produit que sur un seul ordinateur.

3) Limitations relatives aux copies
Vous ne pouvez pas dupliquer ce produit autrement qu’à des fins de sauvegarde.

4) Limitations relatives aux modifications
Vous ne pouvez ni modifier ni désassembler ce produit de quelque façon que ce soit.

5) Limitations relatives au transfert
Vous ne pouvez pas transférer ce logiciel à un tiers ni autoriser un tiers à l’utiliser.

6) Garantie
Nous déclinons toute responsabilité quant à vos choix ou à l’utilisation de ce produit, ou quant à tout 
dommage pouvant découler de son utilisation.

7) Autres
Ce produit est protégé par les lois sur le droit d’auteur.



Merci d’avoir choisi notre produit!
Nous vous remercions d’avoir acheté notre produit. Pour en optimiser l’utilisation et en garantir le bon 
fonctionnement, lisez attentivement ce document puis conservez-le en lieu sûr, avec votre garantie.

Lisez ce manuel avant d’utiliser ce produit

Pour créer de splendides motifs de broderie
Ce système vous permet de créer de nombreux motifs de broderie et de prendre en charge davantage de 
réglages de caractéristiques de broderie (densité du fil, longueur du point, etc.). Le résultat final dépend, 
toutefois, du modèle de la machine à coudre. Nous vous recommandons de réaliser un échantillon avant de 
broder le tissu.

Pour un fonctionnement en toute sécurité
• N'enregistrez aucun fichier sur la « Clé logicielle Palette (Palette Software Key) » pour le transférer ou le stocker. 
• N'insérez pas la « Clé logicielle Palette (Palette Software Key) » dans votre machine à broder.

Pour optimiser la durée utile
• Quand vous rangez la « Clé logicielle Palette (Palette Software Key) », évitez de l'exposer à la lumière directe du 

soleil et de la ranger dans des endroits très humides. Ne rangez pas la « Clé logicielle Palette (Palette Software 
Key) » à proximité d'un radiateur, d'un fer à repasser ou d'un objet produisant de la chaleur.

• Ne renversez pas d'eau ni aucun autre liquide sur la « Clé logicielle Palette (Palette Software Key) ».
• Ne laissez pas tomber la « Clé logicielle Palette (Palette Software Key) » et ne la soumettez à aucun choc.

Pour les réparations ou les réglages
En cas de dysfonctionnement ou si un réglage est requis, contactez votre revendeur Baby Lock.

Remarque
Ni le présent guide de référence ni le manuel d'instructions n'expliquent comment utiliser votre ordinateur sous Windows®. 
Veuillez-vous reporter à la documentation de Windows®.

Marques de commerce
• Windows® est une marque déposée de Microsoft Corporation.
• D’autres noms de produit mentionnés dans ce guide de référence et dans le manuel d’instructions peuvent 

être des marques de commerce ou déposées de leurs détenteurs respectifs.

Important
L'utilisation de ce produit pour copier sans autorisation des données de broderie, des journaux ou des 
magazines, et ce, à des fins commerciales est une infraction au droit d'auteur et est punissable par la loi.

Attention
Le logiciel accompagnant ce produit est protégé par les lois sur le droit d’auteur. Ce logiciel peut être utilisé 
ou copié conformément aux droits d’auteur.

Pour plus d’informations et pour obtenir des mises à jour du produit, visitez 
notre site Web à l’adresse suivante :
www.babylock.com

CONSERVEZ CE MANUEL
Ce produit est réservé à un usage domestique.
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Mise en route

Création du motif
de broderie

souhaité

Des idées à la
broderie

Création de
différents motifs

de broderie

2

Navigation dans ce guide pour 
de meilleurs résultats

Procédure d’installation
Suivez ces premières 
étapes pour installer le 
logiciel.

Pour les utilisateurs qui veulent 
apprendre les opérations 
d’application de base
Je...

.... débute avec Palette.

.... souhaite revoir les opérations 
de base.

Pour les utilisateurs qui 
veulent immédiatement 
commencer à créer des motifs
Je...

.... suis un utilisateur 
intermédiaire/avancé de 
Palette.

.... souhaite découvrir en détail 
des opérations destinées à 
des applications spécifiques.
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Utilisation des manuels

Guide de référence (manuel imprimé/format PDF)
Lisez ce guide avant d’utiliser le logiciel. Ce guide commence par des procédures d'installation du logiciel et 
présente des précautions et des conseils d'utilisation du logiciel. La seconde moitié contient des didacticiels utilisant 
des fonctionnalités principales permettant de créer des motifs de broderie, ainsi que des exemples d’ouvrages.
• Section d’installation

1) Lire les informations relatives à la vérification du contenu de l’emballage et des préparatifs 
d’installation. (c page 5)

2) Installer le logiciel conformément aux instructions. (c page 6)
3) En savoir plus sur la prise en charge du logiciel et l’enregistrement en ligne. (c page 13)

• Section du fonctionnement de base
1) Apprendre les fonctionnalités principales permettant de créer des motifs de broderie. (c page 15)
2) En savoir plus sur les opérations et fonctions de base liées aux écrans. (c page 17)
3) Essayer de créer des exemples d’ouvrages. (c page 28)

• Symboles utilisés dans le guide

Manuel d’instructions
Ce manuel décrit les fonctions et les opérations, ainsi que les divers réglages de Palette pour tous les 
niveaux, des débutants aux utilisateurs avancés.

■ Manuel d'instructions en ligne
Un manuel d'instructions en ligne est disponible, auquel vous pouvez également accéder depuis un 
dispositif mobile. 
Babylock.com/palette11/fr

Affichage à partir de l'écran [Accueil] (pour les utilisateurs de Windows® 10)
Cliquez sur . Cliquez sur [Palette Ver.11], puis sélectionnez [Manuel d'instructions en ligne].

Affichage à partir de l’application
Cliquez sur [Aide] dans la fenêtre de chaque application. Dans [Design Database], [Aide], la barre 
de menu se trouve en haut de la fenêtre.

Dans d'autres applications, elle se situe dans le coin supérieur droit de la fenêtre.

a : Ce symbole indique les précautions à respecter au cours des opérations logicielles. Ces informations 
étant nécessaires pour une utilisation correcte, veillez à les lire dès que vous voyez cette marque.

b : Ce symbole indique des conseils d’utilisation utiles. Grâce à ces informations, vous pourrez créer 
des motifs de broderie plus facilement et de façon plus agréable.

b
• Pour les utilisateurs de Windows® 8.1 : Placez le pointeur de la souris dans l’écran [Accueil] pour afficher la flèche 

vers le bas dans l’angle inférieur gauche de l’écran (en dessous et à gauche des mosaïques) et cliquez dessus.
Dans la liste des applications qui s'affiche à l'écran, cliquez sur [Manuel d'instructions en ligne] sous le titre 
[Palette Ver.11].

• Pour les utilisateurs de Windows® 7 : Cliquez sur  puis sur [Tous les programmes]. Cliquez sur 
[Palette Ver.11], puis sélectionnez [Manuel d'instructions en ligne].
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b
• Le manuel d'instructions est aussi disponible au format PDF pour l'utiliser quand votre ordinateur n'est 

pas connecté à Internet.
• Vous pouvez accéder au manuel d'instructions et au guide de référence au format PDF comme suit :

- Pour les utilisateurs de Windows® 10 : Cliquez sur . Cliquez sur [Palette Ver.11], puis 

sélectionnez [Manuel d’instructions] ou [Guide de référence].
- Pour les utilisateurs de Windows® 8.1 : Placez le pointeur de la souris dans l’écran [Accueil] pour 

afficher la flèche vers le bas dans l’angle inférieur gauche de l’écran (en dessous et à gauche des 
mosaïques) et cliquez dessus. 
Dans la liste des applications qui s'affiche à l'écran, cliquez sur [Manuel d’instructions] ou sur [Guide 
de référence] sous le titre [Palette Ver.11].

- Pour les utilisateurs de Windows® 7 : Cliquez sur  puis sur [Tous les programmes]. Cliquez sur 
[Palette Ver.11] et cliquez sur [PDF], puis sélectionnez [Manuel d’instructions] ou [Guide de 
référence].

• Adobe® Reader® est requis pour afficher et imprimer la version PDF du manuel d'instructions.
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Mise en route

Introduction

Contenu de l'emballage (version complète uniquement)
Vérifiez que les éléments suivants figurent dans l'emballage. Si l'un d'entre eux est manquant ou 
endommagé, contactez votre revendeur Baby Lock.

Précautions relatives à l'utilisation de la « Clé logicielle 
Palette (Palette Software Key) »
• Étant donné que cette « Clé logicielle Palette (Palette Software Key) » est nécessaire à l'exécution du logiciel, pour la 

remplacer, vous devrez payer le prix de vente au détail du logiciel. Conservez-la en lieu sûr lorsque vous ne l’utilisez pas.
• La « Clé logicielle Palette (Palette Software Key) » empêche l'utilisation non autorisée de ce logiciel. Le 

logiciel ne peut pas démarrer si la « Clé logicielle Palette (Palette Software Key) » n'est pas connectée.
• Il est impossible d'utiliser la « Clé logicielle Palette (Palette Software Key) » comme support USB. N'enregistrez 

pas de fichiers de broderie sur la « Clé logicielle Palette (Palette Software Key) » pour les transférer ou les stocker.
• N'insérez pas la « Clé logicielle Palette (Palette Software Key) » dans votre machine à broder.
• Ne formatez pas la « Clé logicielle Palette (Palette Software Key) ».
• N'exposez pas la « Clé logicielle Palette (Palette Software Key) » à un fort degré d'humidité, à la lumière 

directe du soleil, à l'électricité statique ou à des chocs violents. Ne pliez pas non plus la « Clé logicielle 
Palette (Palette Software Key) ».

• Avant de procéder à l'installation, sauvegardez le programme d'installation stocké sur la « Clé logicielle 
Palette (Palette Software Key) ».

• Si l’application installée ne fonctionne pas correctement, réinstallez-la.
• Si l'ordinateur ne démarre pas avec la « Clé logicielle Palette (Palette Software Key) » insérée, débranchez 

la « Clé logicielle Palette (Palette Software Key) », puis allumez l'ordinateur. Insérez la « Clé logicielle 
Palette (Palette Software Key) » de nouveau pour lancer le programme.

Clé logicielle Palette (Palette Software Key)
Contenant le logiciel

* Le design est susceptible de changer.

Guide de référence 
(le présent manuel)

Feuille de positionnement
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Installation
M

ise en route

Installation

Lisez les précautions suivantes avant de procéder à 
l’installation
• Avant de commencer l’installation, vérifiez que l’ordinateur dispose de la configuration minimale requise.
• Pour installer le logiciel sous Windows®, vous devez vous connecter à l'ordinateur à l'aide d'un compte 

disposant des privilèges administrateur. Si vous n'êtes pas connecté en tant qu'administrateur, le mot de 
passe du compte administrateur peut vous être demandé sous Windows®. Entrez le mot de passe pour 
poursuivre. Pour plus de détails sur la connexion à l'ordinateur à l'aide d'un compte disposant des 
privilèges administrateur, consultez le manuel de Windows®.

• La procédure d'installation décrite ici concerne Windows® 10. La procédure et les boîtes de dialogue pour 
d’autres systèmes d’exploitation peuvent être légèrement différentes.

• En cas d’annulation de l’installation avant la fin de ce processus ou si la procédure n’est pas exécutée 
conformément aux instructions, le logiciel ne sera pas installé correctement.

• Ne retirez pas la « Clé logicielle Palette (Palette Software Key) » du port USB de l'ordinateur lorsque 
l'installation est en cours. Retirez la « Clé logicielle Palette (Palette Software Key) » une fois l'installation 
terminée.

Installation

Configuration minimale requise
Avant d’installer le logiciel sur votre ordinateur, vérifiez que ce dernier est conforme aux spécifications 
minimales requises suivantes.

Système d’exploitation Windows® 7, 8.1, 10 (32 ou 64 bits)

Processeur 1 GHz ou plus

Mémoire 1 Go minimum

Espace disque disponible 600 Mo

Écran XGA (1024 × 768), couleur 16 bits ou supérieur

Port
Deux ports USB minimum (utilisés pour connecter la « Clé logicielle Palette 
(Palette Software Key) » et transférer des données de broderie vers une 
machine à broder)

Périphérique Souris

Imprimante Imprimante graphique prise en charge par votre système (si vous souhaitez 
imprimer vos images)

Accès Internet Requis pour mettre Palette à jour

a
• Il peut s’avérer que ce produit ne fonctionne pas correctement avec certains ordinateurs.



7

Installation

Procédure d’installation
Cette section décrit comment installer le logiciel d’application.

a
• Avant de commencer l’installation, respectez la procédure ci-dessous pour sauvegarder le programme 

d’installation sur votre ordinateur.
1) Créez un dossier de sauvegarde sur l’ordinateur.
2) Copiez l'intégralité du dossier [Palette Ver.11] figurant sur la « Clé logicielle Palette (Palette Software 

Key) » dans le dossier créé à l'étape 1.
• Ne supprimez pas les données contenues dans le dossier [Palette Ver.11] sur la « Clé logicielle Palette 

(Palette Software Key) ».

1 Branchez la « Clé logicielle Palette 
(Palette Software Key) » au port USB 
de l'ordinateur.
→ Après un court instant, la boîte de 

dialogue [Lecture automatique] 
s’affiche automatiquement.

→ Pour les utilisateurs de 
Windows® 7, suivez l'étape 3 
après l'ouverture de la boîte de 
dialogue [Lecture automatique].

a
Ne débranchez ni ne branchez pas la « Clé logicielle Palette (Palette Software Key) » tant que l'installation 
n'est pas terminée.

b
Si la boîte de dialogue [Lecture automatique] ne s’affiche pas automatiquement :
• Pour les utilisateurs de Windows® 10/8.1 :

1) Cliquez avec le bouton droit sur  /  et sélectionnez [Exécuter] dans la liste des commandes.
* Pour Windows® 8.1, déplacez le pointeur sur l'angle inférieur gauche de l'écran pour afficher , 

puis cliquez avec le bouton droit sur .
→ La boîte de dialogue [Exécuter] s’affiche.

2) Entrez le chemin d’accès complet au programme d’installation, puis cliquez sur [OK] pour démarrer le 
programme d’installation. 
Par exemple : E:\Palette Ver.11\setup.exe (où « E: » est le nom du lecteur utilisé pour la « Clé 
logicielle Palette (Palette Software Key) »)

• Pour les utilisateurs de Windows® 7 : 
Cliquez sur , puis sur [Tous les programmes]. Sélectionnez [Accessoires], puis cliquez sur 
[Exécuter] pour afficher la boîte de dialogue [Exécuter]. Entrez le chemin d’accès complet au 
programme d’installation dans la fenêtre de saisie.
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M

ise en route

2 Cliquez sur le message qui s'affiche 
dans le coin inférieur droit de 
l'écran.
→ La boîte de dialogue [Lecture 

automatique] continue de 
s’afficher.

3 Cliquez sur [Ouvrir le dossier et 
afficher les fichiers].
→ La fenêtre [Explorateur de 

fichiers] s’affiche.

4 Ouvrez le dossier [Palette Ver.11], 
puis double-cliquez sur le fichier 
[setup.exe].
→ La boîte de dialogue [Contrôle de 

compte d’utilisateur] s’affiche.

5 Cliquez sur [Oui].
→ Après un court instant, la boîte de 

dialogue suivante s’affiche 
automatiquement.
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Installation

6 Sélectionnez la langue souhaitée, 
puis cliquez sur [Suivant].

7 Cliquez sur [Suivant] pour 
poursuivre l’installation.
→ La boîte de dialogue du contrat de 

licence s'affiche.

8 Lisez le contrat de licence. Cochez 
la case [J'accepte les termes de ce 
contrat de licence] si vous acceptez 
les conditions, puis cliquez sur 
[Suivant].
→ Une boîte de dialogue vous 

permettant de sélectionner le 
dossier dans lequel le logiciel sera 
installé apparaît.

9 Vérifiez l'emplacement de 
l'installation, puis cliquez sur 
[Installer] pour installer l'application.
→ Une fois l’installation terminée, la 

boîte de dialogue suivante s’affiche.

b
Pour installer l’application dans un autre dossier :

1) Cliquez sur [Modifier].
2) Dans la boîte de dialogue [Rechercher un dossier] qui s’affiche, sélectionnez le lecteur et le dossier. 

(Au besoin, entrez le nom d’un nouveau dossier.)
3) Cliquez sur [OK].

→ La boîte de dialogue [Dossier de base de données] de l’[InstallShield Wizard] affiche le dossier 
sélectionné.

4) Cliquez sur [Installer] pour installer l’application dans le dossier sélectionné.
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M

ise en route

10 Cliquez sur [Terminer] pour terminer 
l’installation du logiciel.

b
• Si un message indiquant que l’ordinateur doit être redémarré s’affiche, vous devez le redémarrer.
• Si la case [Afficher le manuel d'instruction en ligne] est cochée, le manuel d'instructions en ligne 

s'ouvre une fois l'installation terminée.
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Désinstallation du logiciel

1 Cliquez sur , 

puis cliquez sur .

2 Cliquez sur [Applications].

3 Dans la fenêtre [Applications et 
fonctionnalités], sélectionnez 
[Palette Ver.11] et cliquez sur 
[Désinstaller].
→ Le message [Cette application et 

les informations qui lui sont 
associées vont être 
désinstallées.] s'affiche.
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4 Cliquez sur [Désinstaller].
Si le message [Contrôle de compte 
d’utilisateur] apparaît, cliquez sur 
[Oui].

b
• La procédure de désinstallation décrite ici concerne Windows® 10.
• Pour Windows® 8.1, cliquez avec le bouton droit sur [Palette Ver.11 (Layout & Editing)] sur l'écran 

[Applications], puis cliquez sur [Désinstaller] dans la barre des tâches en bas de l'écran. Sélectionnez 
ce logiciel dans la fenêtre [Programmes et fonctionnalités], puis cliquez sur [Désinstaller].

• Pour Windows® 7, cliquez sur le bouton [Accueil], puis sur [Panneau de configuration]. Sélectionnez 
[Programmes et fonctionnalités] dans la fenêtre [Panneau de configuration]. Sélectionnez ce 
logiciel, puis cliquez sur [Désinstaller].
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Assistance/Service technique

Assistance technique
En cas de problème, cliquez sur [Aide] à l'écran et sélectionnez [Support clientèle] pour accéder à la 
« Forum aux questions » de notre site d'assistance à la clientèle (https://www.babylock.com/support/faq/). 
Vous y trouverez les causes et les solutions à divers problèmes, ainsi que des réponses aux questions les 
plus fréquemment posées.

Contactez l'assistance produit de Baby Lock si votre problème n'y est pas mentionné. Accédez au site 
www.babylock.com, puis cliquez sur « Customer support ».

Enregistrement en ligne
Si vous souhaitez être informé des mises à niveau et recevoir des informations importantes sur les prochains 
développements et améliorations du produit, enregistrez votre produit en ligne en suivant une procédure 
simple.

Cliquez sur [Enregistrement en ligne] dans le menu [Aide] de [Layout & Editing] pour lancer le navigateur 
Web installé et accéder à la page d'enregistrement en ligne sur notre site Web.

www.babylock.com/register

a
Avant d’accéder au site Web :

1) Mettez votre système d'exploitation Windows® à jour vers la version la plus récente.
2) Vous devez connaître la marque et le modèle de l'ordinateur que vous utilisez, ainsi que la version du 

système d'exploitation Windows®.
3) Vous devez obtenir des informations sur les messages d’erreur qui pourraient s’afficher. Celles-ci 

permettront d’accélérer le traitement de vos requêtes.
4) Vous devez vérifier et mettre à jour le logiciel vers la toute dernière version.

a
L’enregistrement en ligne peut ne pas être possible dans certaines régions.
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M

ise en route

Vérification de la dernière version du 
programme

1 Cliquez sur [Aide] dans [Layout & 
Editing], puis sur [Recherche de 
mises à jour].
→ Le logiciel est vérifié afin de 

déterminer s’il s’agit de la dernière 
version.

2 Si le message montré à gauche 
s’affiche, cliquez sur [OK].
La dernière version du logiciel est 
utilisée.

3 Si le message montré à gauche 
s’affiche, cliquez sur [Oui] pour 
lancer le téléchargement de la 
dernière version du logiciel à partir 
du site Web.

a
• Cette fonction ne peut pas être utilisée si l’ordinateur n’est pas connecté à Internet.
• La recherche de la dernière version peut s’avérer impossible si un pare-feu est activé. Désactivez le 

pare-feu, puis essayez d’effectuer de nouveau l’opération.
• Des privilèges d’administrateur sont requis.

b
Si la case [Toujours rechercher la dernière version au démarrage] est cochée, le logiciel est vérifié au 
démarrage pour vérifier s’il s’agit de la dernière version.
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